IBM Cognos Business Intelligence
Version 10.2.0

Getting Started Installation Guide
Contents

Chapter 1. Introduction ........................................... 1

Chapter 2. Install Cognos BI on one computer ...................... 3
  System requirements ........................................... 3
  Installing the server components ................................ 4
  Installing Framework Manager .................................. 5
  Create a content store database .................................. 6
    Creating a content store in IBM DB2 ............................ 6
    Creating a content store in Microsoft SQL Server ............... 7
  Saving your settings and starting the IBM Cognos services ....... 8
  Confirming that Content Manager is running ...................... 8
  Configure your web server ........................................ 9
    Using the CGI gateway on Microsoft Internet Information Services version 7 . ...................... 9
    Using the CGI gateway on Apache Server or IBM HTTP Server ....... 10
  Testing your access to the portal .................................. 10
  Configuring Framework Manager on a 64-bit computer .............. 11

Chapter 3. Installing the Cognos Business Intelligence samples ....... 13
  Creating the sample databases in IBM DB2 ......................... 13
    Creating data source connections to the samples database in IBM DB2 .................. 14
  Creating the sample databases in Microsoft SQL Server ............. 15
    Creating data source connections to the samples database in Microsoft SQL Server .... 15
  Importing the samples ........................................... 16

Chapter 4. Add components to your installation ..................... 19
  Add an Application Tier Components instance .................... 20
    Set the server name for your existing instance .................. 21
  Install an Application Tier Components instance ................ 22
  Configure the Application Tier Components instance ............... 22
  Test your Application Tier Components instance ................... 23
  Add a web gateway .............................................. 24
    Install a web gateway .......................................... 24
    Configure the gateway ......................................... 25
    Configure your web server ..................................... 25
    Test your access to your second portal ................. 27

Appendix. Accessibility features ................................ 29
  Keyboard Shortcuts for the Installation Wizard ................. 29

Notices .......................................................... 31

Index ............................................................. 35
Chapter 1. Introduction

This document is intended for use with IBM® Cognos® Business Intelligence. Cognos BI is a Web-based business intelligence solution with integrated reporting, analysis, scorecarding, and event management features.

This document provides the information you need to install and configure Cognos BI on a Microsoft Windows operating system using a single-server installation with default settings. This installation is the quickest and easiest way to get started, and suitable for setting up a test or evaluation environment.

Additional tasks are provided to extend the single-server installation by adding components to your installation. Further information on distributed installations, however, is provided in the *IBM Cognos Business Intelligence Installation and Configuration Guide*.

**Audience**

To use this guide, you should be familiar with:

- Some database concepts
- Basic Microsoft Windows operating system administration skills
- Web server configuration

**Finding information**

To find IBM Cognos product documentation on the web, including all translated documentation, access one of the [IBM Cognos Information Centers](http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp). Release Notes are published directly to Information Centers, and include links to the latest technotes and APARs.

You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

**Accessibility Features**

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. This product has accessibility features. For information on these features, see "Keyboard Shortcuts for the Installation Wizard" on page 29.

**Forward-looking statements**

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

© Copyright IBM Corp. 2005, 2012
Samples disclaimer

The Great Outdoors Company, GO Sales, any variation of the Great Outdoors name, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample applications. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Chapter 2. Install Cognos BI on one computer

This chapter provides the information you need to install and configure IBM Cognos Business Intelligence on a single computer with default settings. This type of installation is suitable for a test or evaluation environment.

This document provides you with the information you need to install Cognos BI under the following conditions:

- Installing on a single Microsoft Windows computer.
- Using either Cognos Content Database, IBM DB2®, or Microsoft SQL Server as the content store.
- Using Microsoft Internet Information Services (IIS), Apache Web Server, or IBM HTTP Server as the web server.
- Using the default Apache Tomcat as the application server.
- Without enabling security.

The remaining chapters provide information about installing the samples, and about extending the single-server installation by adding components to your installation.

Further information about customizing the installation, distributing the components across multiple computers, with another database or application server, or about upgrading an existing installation is provided in the *IBM Cognos Business Intelligence Installation and Configuration Guide*.

System requirements

Use the following tables to check the minimum hardware and software requirements to install and run IBM Cognos Business Intelligence components on one computer. Additional resources may be required for distributed or production environments.

*Table 1. Hardware requirements*

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft Windows</td>
</tr>
<tr>
<td>RAM</td>
<td>Between 8 and 10 GB. Note: Memory settings depend on many factors, such as the level of activity expected on the server, the complexity of the IBM Cognos applications, the number of users and requests, and acceptable response times.</td>
</tr>
<tr>
<td>Disk space</td>
<td>A minimum of 3.5 GB of free space is required to install the software and 4 GB of free space on the drive that contains the temporary directory used by IBM Cognos components. For all databases, the size will increase over time. Ensure that you have sufficient disk space for future requirements.</td>
</tr>
</tbody>
</table>

*Table 2. Software requirements*

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web server</td>
<td>A web server must be installed and started.</td>
</tr>
</tbody>
</table>
Table 2. Software requirements (continued)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Cognos Content Database can be installed and configured as the default content store database in a test or proof-of-concept system. If you do not install the Cognos Content Database component, you can use another database, including IBM DB2, Microsoft SQL Server, Oracle, Sybase, or Informix®. This document includes steps for using Cognos Content Database, IBM DB2, and Microsoft SQL Server. For the other databases, see the IBM Cognos Business Intelligence Installation and Configuration Guide. TCP/IP connectivity is required for all database types.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Web browser</th>
<th>For all web browsers, the following options must be enabled:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Cookies</td>
</tr>
<tr>
<td></td>
<td>• JavaScript</td>
</tr>
<tr>
<td></td>
<td>For Microsoft Internet Explorer only, the following options must be enabled:</td>
</tr>
<tr>
<td></td>
<td>• Run ActiveX controls and plug-ins</td>
</tr>
<tr>
<td></td>
<td>• Script ActiveX controls marked safe for scripting</td>
</tr>
<tr>
<td></td>
<td>• Active scripting</td>
</tr>
<tr>
<td></td>
<td>• Allow META REFRESH</td>
</tr>
</tbody>
</table>

### Installing the server components

Use the installation wizard to copy all the components to your computer.

If you are installing on a computer running the Windows Vista, Windows 7, or Windows 2008 operating system, the default installation location uses the Program Files (x86) directory. If you install to this location, ensure that you run IBM Cognos Configuration as an Administrator. Alternatively, you can install the product outside of the Program Files (x86) directory. For example, you can change the installation directory to something like C:\ibm\cognos\c10.

### Before you begin

To ensure that your product works properly, apply all required operating system patches and use only the versions of other software that are supported for an IBM Cognos product.

To review an up-to-date list of environments supported by IBM Cognos products, such as operating systems, patches, browsers, Web servers, and database servers, visit the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).

### Procedure

1. Insert the IBM Cognos product disk or go to the location where the installation files were downloaded and extracted.
   To manually start the installation wizard, go to the operating system directory and then double-click the issetup.exe file.
2. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You can change the language of the user interface to any of the installed languages after installation.

3. Accept the defaults on the Component Selection page to install all the required components.
   If you want to install the Cognos Content Database, expand IBM Cognos Business Intelligence Server, and select Cognos Content Database.
   If you do not install Cognos Content Database, you can use an IBM DB2 or Microsoft SQL Server database for your content store. Information about using other databases is provided in the IBM Cognos Business Intelligence Installation and Configuration Guide.
   If you will also be installing the samples, you must have access to another database, such as IBM DB2 or Microsoft SQL Server. You cannot restore the samples to the Cognos Content Database.

4. Click Next and follow the directions in the wizard to complete the installation.

5. When you are prompted about installing non-English product documentation, click OK to continue.

### Installing Framework Manager

To install Framework Manager, use the installation wizard to copy all of the components to a Microsoft Windows operating system computer.

If you have installed the 32-bit version of the IBM Cognos Business Intelligence server components, install Framework Manager to the same directory as the server components. This means you will not have to configure Framework Manager separately from the server components.

If you have installed the 64-bit version of the Cognos BI server components, you must install Framework Manager to a different directory. The default installation locations for 32 and 64-bit components are different. If you have installed the 64-bit version of the server components, you will have to configure Framework Manager.

### Procedure

1. Insert the disk for your IBM Cognos modeling product, and then open the installation menu.
   The Welcome page of the installation wizard appears. If the Welcome page does not appear, in the win32 directory on the disk, double-click issetup.exe.
2. Select the language to use, and click Next.
3. On the IBM License Agreement panel, select I Agree, and click Next.
4. On the Installation Location panel, accept the default, and click Next.

   **Important:** If you installed the 64-bit version of the IBM Cognos BI server components, do not attempt the install Framework Manager to that same location. If you installed the 32-bit version of the server components, the default location will be the same as the server location.

5. On the Component Selection panel, accept the default, and click Next.
6. On the Shortcut Folder panel, do one of the following:
   - If you have installed the 32-bit version of the server components, you can accept the default value in the Program Folder box, and click Next.
• If you have installed the 64-bit version of the server components, enter IBM Cognos 10 Framework Manager in the Program Folder box, and click Next.

7. On the Installation Summary panel, click Next and complete the installation.

Create a content store database

The content store is a database that Content Manager uses to store global configuration data, global settings (such as the language and currency formats shown in the user interface), connections to data sources, and product-specific content.

If you selected Cognos Content Database during the installation, you do not need to create a content store database. A database is created and pre-configured during the installation, and you can proceed to “Saving your settings and starting the IBM Cognos services” on page 8.

If you are using IBM DB2, you create a script from IBM Cognos Connection which you use to create a suitable database for the content store. For more information, proceed to “Creating a content store in IBM DB2.”

For Microsoft SQL Server, you must create the database manually. For more information, proceed to “Creating a content store in Microsoft SQL Server” on page 7.

Creating a content store in IBM DB2

To use an IBM DB2 database for your content store, you must copy two Java Archive (jar) files, and then use IBM Cognos Configuration to create a script to use in the IBM DB2 tools to create a suitable database for the content store.

Before you begin

You must have DB2 installed, and the database user account must exist.

Procedure

1. Copy the following files from DB2_installation\sql1ib\java directory to the c10_location\webapps\p2pd\WEB-INF\lib directory:
   • The universal driver file, db2jcc.jar
   • The license file, db2jcc_license_cu.jar
   If you installed IBM Cognos BI to the default location, copy the files to C:\Program Files\ibm\cognos\c10\webapps\p2pd\WEB-INF\lib directory.
2. From the Start menu, click Programs then click IBM Cognos 10 then click IBM Cognos Configuration.
3. In the Explorer window, under Data Access, Content Manager, click Content Store.
4. In Database server and port number, enter the name of your computer and the port number on which DB2 is running. For example, localhost:50000. 50000 is the default port number used by DB2. If you are using a different port number, ensure you use that value.
5. Click the Value field next to the User ID and password property and then click the edit button when it appears. Type the appropriate values and click OK.
6. In the Properties window, for the Database name property, type the name for your content store database.
Important: Do not use a name longer than eight characters and use only letters, numbers, underscores, and hyphens in the name.

7. Right-click Content Store, and click Generate DDL.
8. Click Details to record the location of the generated DDL file.

   The DDL file named create08.sql is created. The script is created in the cl0_location\configuration\schemas\content\db2 directory.

9. Click File then click Save to save your settings.

10. Log in as the IBM DB2 user, and, from the IBM DB2 Control Center, open the Command Editor, and the open and run the create08.sql DDL file to create the database.

11. When the script has completed successfully, you can log back in as your Cognos user or your regular user account.

Creating a content store in Microsoft SQL Server

If you are using Microsoft SQL Server, you must manually create the database to use as a content store database. Then you can set the connection properties to the database in IBM Cognos Configuration.

Procedure

1. Create a database using your Microsoft SQL Server administration tools.
   a. Ensure that the collation sequence for the database is case insensitive.
      In a custom installation, you choose a collation sequence, which includes character sets and sort order, during the Microsoft SQL Server setup. In a typical installation, the installation uses the locale identified by the installation program for the collation. This setting cannot be changed later.
      b. Ensure that TCP/IP connectivity is used for Microsoft SQL Server.

2. From the Start menu, click Programs then click IBM Cognos 10 then click IBM Cognos Configuration.

3. In the Explorer window, under Data Access, Content Manager, right-click Content Store, and click Delete.

   This removes the default content store properties, which are defaulted to use an IBM DB2 database.

4. Right-click Content Manager, and click New Resource then click Database.

5. In the Name field, type a name for the resource. Such as Content Store.

6. In the Type box, select the appropriate Microsoft SQL Server database type, and click OK.

   If you use Windows authentication for your Microsoft SQL Server database, select Microsoft SQL Server database (Windows authentication). If not, select Microsoft SQL Server database.

7. In Database server and port number, enter the name of your computer and port number on which Microsoft SQL Server is running. For example, localhost:1433. The value 1433 is the default port number used by Microsoft SQL Server. If you are using a different port number, ensure you use that value.

8. Click the Value field next to the User ID and password property and then click the edit button when it appears. Type the appropriate values and click OK.

9. In the Properties window, for the Database name property, type the name for your content store database.
10. Right-click the resource you added for the content store database, and click Test. If the test is successful, Content Manager can create the required tables in the content store when you start the IBM Cognos service for the first time. If the connection properties are not specified correctly, you cannot start the IBM Cognos services.

**Saving your settings and starting the IBM Cognos services**

You must save your configuration settings and start the IBM Cognos service before users can access IBM Cognos Connection, the product portal.

**Procedure**

1. If you have not already started IBM Cognos Configuration, from the Start menu, click Programs then click IBM Cognos 10 then click IBM Cognos Configuration.

2. In IBM Cognos Configuration, click File then click Save to save your configuration settings.

3. Click Actions then click Start.

   It may take a few minutes for the IBM Cognos service to start.

   You will receive a warning during the Testing the mail server connection process. Click OK and Continue to continue starting the services. A mail server connection is not required.

   If you have installed the Cognos Content Database component, the Cognos Content Database service will also be started.

**Confirming that Content Manager is running**

You can confirm that Content Manager is running using a web browser.

**Procedure**

1. Open a web browser.

2. Type the Content Manager URI value from IBM Cognos Configuration in your Web browser address bar, and press Enter.

   For example, type http://localhost:9300/p2pd/servlet
   localhost can be your computer name, or IP address, or localhost.
   9300 is the default port number used by IBM Cognos components.

**Results**

The State value should be Running. This indicates that your IBM Cognos services have started, and that they have connected to the content store.

If the State is not Running, ensure that you have entered the correct information to connect to your content store database and that the services have been started in IBM Cognos Configuration.

**What to do next**

After you verify that Content Manager is running, you can configure your Web server to allow access to the portal from a web browser.
Configure your web server

You must configure your web server before users can connect to the IBM Cognos BI portal.

Using the CGI gateway on Microsoft Internet Information Services version 7

If you are using Microsoft Internet Information Services (IIS) version 7 or later, use the following task to configure the CGI gateway.

Procedure

1. Click Start then click Control Panel then click Programs and Features.
2. Click Turn Windows features on or off.
3. If you are using Microsoft Windows 2008 Server, take the following steps:
   a. Click Server Manager then click Roles then click Web Server (IIS).
   b. If CGI is set to Not installed, select CGI and click Add Role Service.
4. If you are using Microsoft Windows 7, take the following steps:
   a. Expand Internet Information Services then click World Wide Web Services then click Application Development Features.
   b. If CGI is not selected, select CGI.
   c. Click OK.
5. In the Internet Information Services (IIS) Manager console, under Connections, select your server name.
   If you are using Microsoft Windows 7, click Start > Control Panel > System and Security then click Administrative Tools to access the IIS Manager console.
6. In the IIS group, double-click ISAPI and CGI Restrictions.
7. Under Actions, click Add.
8. Enter the path to the cognos.cgi file. The file is located in the $c10_location\cgi-bin directory.
   You must enter the full path including the filename. If the path includes spaces, ensure you use quotation marks around the path. For example, enter: "C:\Program Files\ibm\cognos\c10\cgi-bin\cognos.cgi"
9. Enter a Description, such as Cognos CGI.
10. Select Allow extension path to execute, and click OK.
11. Under Actions, click Edit Feature Settings, select Allow unspecified CGI modules, and click OK.
12. Under Connections, expand Sites, and under your web site, add the virtual directories as shown in the table:

   Table 3. Required virtual directories

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos</td>
<td>$c10_location\webcontent</td>
</tr>
<tr>
<td>ibmcognos/cgi-bin</td>
<td>$c10_location\cgi-bin</td>
</tr>
</tbody>
</table>

13. Select the cgi-bin virtual directory you created.
14. In the IIS group, double-click Handler Mappings.
15. Under Actions, click Add Module Mapping and take the following steps:
   a. In Request Path, type cognos.cgi.
b. In Module, select CgiModule.
c. Leave Executable (optional) blank.
d. In Name, enter a name for the entry, such as CognosCGI.
e. Click OK.

Results

Users can access the CGI gateway by entering http://servername/ibmcognos in their Web browsers.

Using the CGI gateway on Apache Server or IBM HTTP Server

The default gateway configured in IBM Cognos Configuration is the CGI gateway. To use the CGI gateway, you must configure aliases for Apache Server or IBM HTTP Server.

Procedure
1. Go to the Webserver_installation/conf directory.
2. Open the httpd.conf file in an editor.
3. Ensure that both the server name and web server port number values are specified for the ServerName property.
4. Add the following:

   ScriptAlias /ibmcognos/cgi-bin "c10_location/cgi-bin"

   <Directory "c10_location/cgi-bin">
   AllowOverride None
   Options None
   Order allow,deny
   Allow from all
   </Directory>

   Alias /ibmcognos "c10_location/webcontent"

   <Directory "c10_location/webcontent">
   Options Indexes MultiViews
   AllowOverride None
   Order allow,deny
   Allow from all
   </Directory>
   The <Directory> directive is optional.

   Tip: Ensure that you define the /ibmcognos/cgi-bin alias before the /ibmcognos alias.

5. Save and close the file.
6. Restart the web server.

Results

Users can access the portal at http://servername:port/ibmcognos.

Testing your access to the portal

You can test your access to the portal using your web browser. Accessing the portal, will also verify whether or not your installation is running.
**Procedure**

1. Open a web browser.
2. Test the connection to the IBM Cognos BI portal by typing the **Gateway URI** value from IBM Cognos Configuration. For example, type:
   
   http://host_name/ibmcognos
   
   If you are on the computer where your Web server is installed, you can enter localhost for the *host_name* value.
   
   When you see the **Welcome** page of IBM Cognos Connection, your IBM Cognos BI installation is running.
3. Optionally, from the **Start** menu, click **Programs, IBM Cognos 10, Framework Manager**.
   
   The **Welcome** page of Framework Manager will appear.

**What to do next**

After you verify that the product is running, you can deploy the samples.

---

**Configuring Framework Manager on a 64-bit computer**

If you have installed the 64-bit version of the IBM Cognos BI server components, you will have had to install Framework Manager to a different location than the server components. In this case, you must configure Framework Manager to access the server components.

While you will not have to change any values to configure Framework Manager, you must save the settings to be able to open Framework Manager and access the portal.

**Procedure**

1. From the **Start** menu, click **Programs** then click **IBM Cognos 10 Framework Manager** then click **IBM Cognos Configuration**.

   **Note:** The **IBM Cognos 10 Framework Manager** value corresponds to what you entered when you installed Framework Manager.

2. From the **File** menu, click **Save**.
Chapter 3. Installing the Cognos Business Intelligence samples

To use the samples, install them from the IBM Cognos Business Intelligence samples disk or from the location where you downloaded and extracted the files.

**Procedure**

1. Insert the IBM Cognos samples disk or go to the location where the installation files were downloaded and extracted.
2. Go to the operating system directory and double-click `issetup.exe`.
   - The Welcome page of the installation wizard appears.
   - If the IBM Cognos service is running, you will be prompted to stop the service to continue with the samples installation.
3. Select the language to use for the installation wizard.
4. Follow the directions in the installation wizard.
   - Install the samples in the same location as you installed the server components.
5. In the Finish page of the installation wizard, click Finish.
   - After you complete the samples installation, you must restart the IBM Cognos service.
6. From the Start menu, click Programs > IBM Cognos 10 > IBM Cognos Configuration.
7. Click Actions the click Start.
   - It may take a few minutes for the IBM Cognos service to start.
   - You will receive a warning during the Testing the mail server connection process. Click OK and Continue to continue starting the services.

**Results**

You can now set up the samples. To set up the samples, you must perform several tasks, such as restoring the samples databases and creating data source connections. After setting up the samples, you can use them to learn how to use IBM Cognos software.

**Creating the sample databases in IBM DB2**

Use the provided script to create the sample database on your IBM DB2 database server.

**Before you begin**

You must be logged in as a user with permission to create databases in IBM DB2.

**About this task**

To set up the sample database, you must extract the `GS_DB.tar.gz` file, customize a configuration file, and run the setup script.

When you run the script, you will be prompted to confirm or provide configuration information for the sample database. You can accept the default...
settings or provide different settings to replace the defaults.

**Procedure**

1. Go to the `cl0_location/webcontent/samples/datasources/db2` directory.
2. Extract the `GS_DB.tar.gz` file and retain the original directory structure.

    **Important:** If you use WinZip to extract the DB2 move file on Microsoft Windows operating system, ensure that the **TAR file smart CR/LF conversion** option is not selected. The option is located in the **Options > Configuration > Miscellaneous** tab of Winzip.
3. In a command window, go to the location where you extracted the `GS_DB.tar.gz` file.
4. Go to the `win` folder.
5. Run the `setupGSDB.bat` file.

    The script displays a summary of your choices before you commit to changes to your environment. If you approve the choices, press Enter and the script makes the changes.

    The script may take several minutes to complete.

**Creating data source connections to the samples database in IBM DB2**

You must create data source connections to the samples database that you restored. While there is one database restored in IBM DB2, you must create two data source connections. Both connections point to the same database.

**Before you begin**

The DB2 database name that you type must use uppercase letters. Also, in Framework Manager, the schema names that you type for the DB2 data sources must use uppercase letters.

**Procedure**

1. Open IBM Cognos Administration by connecting to the Cognos BI portal and clicking **Administer IBM Cognos Content** on the **Welcome** page.
2. Click the **Configuration** tab, and click **Data Source Connections**.
3. Click the new data source icon.
4. In the **Name** box, type `great_outdoors_sales` and then click **Next**.
5. In the connection page, select **IBM DB2**, clear **Configure JDBC connection**, and click **Next**.

    The connection string page for the selected database appears.
6. In the **DB2 database name** field, type `GS_DB` using uppercase letters. If you used another name when you restored the sample database, enter that name.
7. Leave **DB2 connect string** blank.
8. Under **Signons**, select both **Password** and **Create a signon that the Everyone group can use**, type the user ID and password for the user that you created for the sample database, and then click **Finish**.

    **Tip:** To test whether the parameters are correct, click **Test the connection**. After testing the connection, click **OK** to return to the connection page.
9. Click **Finish**.
10. Click the new data source icon to create a second connection.
11. In the Name box, type great_outdoors_warehouse and then click Next.
12. In the connection page, select IBM DB2, clear Configure JDBC connection, and click Next.
   The connection string page for the selected database appears.
13. In DB2 database name, type GS_DB using uppercase letters. If you used another name when you restored the sample database, enter that name.
14. Leave DB2 connect string blank.
15. Under Signons, select both Password and Create a signon that the Everyone group can use, type the user ID and password for the user that you created for the sample database, and then click Finish.
   Tip: To test whether the parameters are correct, click Test the connection. After testing the connection, click OK to return to the connection page.
16. Click Finish.

Creating the sample databases in Microsoft SQL Server
You must manually restore the databases if you are using Microsoft SQL Server.

Before you begin
Ensure that TCP/IP connectivity is enabled for the Microsoft SQL Server databases.

Procedure
1. Go to the c10_location/webcontent/samples/datasources/sqlserver directory.
2. Uncompress the GOSALES.zip and GOSALESDW.zip files.
3. Restore the uncompressed files using the Microsoft SQL Server administration tools.
   Restore the file from a device, and ensure that the restore locations are correct for the .ldf and .mdf database files.
   Restore the Gosales database as GOSALES and restore Gosalesdw database as GOSALESDW.

Creating data source connections to the samples database in Microsoft SQL Server
You must create two data source connections to the samples database that you restored.

Procedure
1. Open IBM Cognos Administration by connecting to the IBM Cognos BI portal and clicking Administer IBM Cognos Content on the Welcome page.
2. Click the Configuration tab, and click Data Source Connections.
3. Click the new data source icon.
4. In the Name field, type great_outdoors_sales and then click Next.
5. In the connection page, select Microsoft SQL Server (OLE DB), clear Configure JDBC connection, and click Next.
   The connection string page for the selected database appears.
6. In the **Server name** field, type the name of the computer where Microsoft SQL Server is installed.

7. In the **Database name** field, enter `GOSALES`.

8. Under **Signons**, select both **Password** and **Create a signon that the Everyone group can use**, type the user ID and password for the user that you created for the sample database, and then click **Finish**.

   **Tip:** To test whether the parameters are correct, click **Test the connection**. After testing the connection, click **OK** to return to the connection page.

9. Click **Finish**.

10. Click the new data source icon to create a second connection.

11. In the **Name** field, type `great_outdoors_warehouse` and then click **Next**.

12. In the connection page, select **Microsoft SQL Server (OLE DB)**, clear **Configure JDBC connection**, and click **Next**.

   The connection string page for the selected database appears.

13. In the **Server name** field, type the name of the computer where Microsoft SQL Server is installed.

14. In the **Database name** field, enter `GOSALESWM`.

15. Under **Signons**, select both **Password** and **Create a signon that the Everyone group can use**, type the user ID and password for the user that you created for the sample database, and then click **Finish**.

   **Tip:** To test whether the parameters are correct, click **Test the connection**. After testing the connection, click **OK** to return to the connection page.

16. Click **Finish**.

---

**Importing the samples**

To use the sample package and other content, you must import them from the sample deployment archive.

**Procedure**

1. Copy the `IBM_Cognos_Samples.zip` file from the `c10_location/webcontent/samples/content` directory to the `c10_location/deployment` directory.

2. Open a web browser.

3. Enter the **Gateway URI** value from IBM Cognos Configuration in the address bar, and press Enter.

   For example, enter
   ```
   http://host_name/ibmcognos
   ```

   If you are on the computer where your web server is installed, you can enter localhost for the `host_name` value.

4. On the **Welcome** page, click **Administer IBM Cognos Content**.

5. On the **Configuration** tab, click **Content Administration**.

6. On the toolbar, click **New Import**.

7. In the **Deployment Archive** pane select the archive you want to import.

   You can import only one deployment at a time. To start, select `IBM_Cognos_Samples`.

8. Click **Next**.
9. If you want, type a unique name and an optional description and screen tip for the deployment archive, select the folder where you want to save it, and then click **Next**.

10. In the **Public Folders Content** pane, select the folders that you want to import.

11. If you want, select the options along with your conflict resolution choice for options that you select, and then click **Next**.

12. In the **Specify the general options** pane, select whether to include access permissions and references to external namespaces, and who should own the entries after they are imported.

13. Click **Next**.
   
   The summary information appears.

14. Review the summary information and click **Next**.

15. Select the action that you want:
   - To run once now or later, click **Save and run once**. Click **Finish**, specify the time and date for the run, then click **Run**. Review the run time and click **OK**.
   - To schedule at a recurring time, click **Save and schedule**. Click **Finish**, and then select frequency and start and end dates. Click **OK**.

   **Tip:** To temporarily disable the schedule, select the **Disable the schedule** check box.

   - To save without scheduling or running, click **Save only** and click **Finish**.

16. When the import is submitted, click **Finish**.

**What to do next**

You can now use the sample packages to create reports and analyses using the IBM Cognos Business Intelligence studios. You can also run the sample reports that are available on the **Public Folders** tab under **Samples/Models** in the portal.

For more information about using the product, see the *IBM Cognos Getting Started Guide*. 

Chapter 4. Add components to your installation

To improve performance, you can add components to your Cognos BI installation.

To improve reporting performance in your IBM Cognos environment you can add Application Tier Component instances. You can also add a second gateway to your installation.

Examples

If you used the installation tasks described in this document, your IBM Cognos installation should appear as shown in the following diagram.

![Diagram of a single server installation](image)

Figure 1. Single server installation

Adding components to your installation, can result in an installation that appears as shown in the following diagram.
Add an Application Tier Components instance

To improve reporting performance in your IBM Cognos environment, you can add Application Tier Component instances.

Adding an Application Tier Components instance will make your installation appear as shown in the following diagram.
Set the server name for your existing instance

When you distribute components over multiple instances, you must use the computer name or IP address for the values in IBM Cognos Configuration.

From figure 1, you would perform this task on your Server_1 computer.

Procedure

1. For your existing server installation, open IBM Cognos Configuration.
2. In the Explorer pane, click Environment.
3. Change localhost to the name or IP address where you are running the instance in the following fields:
   - Gateway URI
   - Dispatcher URIs for gateway
   - External dispatcher URI
   - Internal dispatcher URI
   - Dispatcher URI for external applications
   - Content Manager URIs

   For example, change the External dispatcher URI value from http://localhost:9300/p2pd/servlet to http://Server_1:9300/p2pd/servlet.

   From figure 1, Server_1 is the server name of your existing instance.
4. Click the field for Dispatcher URIs for gateway, and click the edit button.

   The Value - Dispatcher URI for gateway window appears.
   a. In the Current values list, change localhost to the name or IP address where you are running the instance.

Figure 3. Adding an Application Tier Components instance
For example, change the value from http://localhost:9300/p2pd/servlet to http://Server_1:9300/p2pd/servlet.

Server_1 is the server name of your existing instance.

b. Click OK.

5. Click the field for **Content Manager URIs**, and click the edit button.

   The **Value - Content Manager URIs** window appears.

   a. In the **Current values** list, change localhost to the name or IP address where you are running the instance.

      For example, change the value from http://localhost:9300/p2pd/servlet to http://Server_1:9300/p2pd/servlet.

      Server_1 is the server name of your existing instance.

   b. Click OK.

6. Click **File** then click **Save**.

7. Click **Action** then click **Restart** to restart the services.

## Install an Application Tier Components instance

You install an Application Tier Components instance by selecting only that component in the installation wizard.

From [figure 2](image) you would perform this task on your **Server_2** computer.

**Procedure**

1. Insert the IBM Cognos product disk or go to the location where the installation files were downloaded and extracted.

   To manually start the installation wizard, go to the operating system directory and then double-click the **issetup.exe** file.

2. Select the language to use for the installation.

   The language that you select determines the language of the user interface. You can change the language of the user interface to any of the installed languages after installation.

3. On the **Component Selection** page, expand IBM Cognos Business Intelligence Server to display the components.

4. Click **Gateway** and **Content Manager** so that they indicate **Not selected**.

   Ensure only **Application Tier Components** is indicated as **Selected**.

5. Click **Next** and follow the directions in the wizard to complete the installation.

6. When you are prompted about installing non-English product documentation, click **OK** to continue.

## Configure the Application Tier Components instance

You must configure your Application Tier Components instance to connect to your Content Manager component and to your gateway component. With a separate Application Tier Components instance you use the Content Manager and gateway components that have already installed.

The Content Manager component will register the Application Tier Components instance, and will manage the traffic among the servers.

**Procedure**

1. For your Application Tier Components installation, open IBM Cognos Configuration.
2. In the **Explorer** panel, click **Environment**.

3. Change localhost to the name or IP address where you are running the Application Tier Components instance in the following fields:
   - **External dispatcher URI**
   - **Internal dispatcher URI**
   - **Dispatcher URI for external applications**
   For example, change the **External dispatcher URI** value from http://localhost:9300/p2pd/servlet to http://Server_2:9300/p2pd/servlet. From **figure 2**, **Server_2** is the Application Tier Components instance you are adding.

4. Change the **Gateway URI** value from http://localhost:80/ibmcognos/cgi-bin/cognos.cgi to http://Server_1:80/ibmcognos/cgi-bin/cognos.cgi. Where **Server_1** is the name or IP address for your existing IBM Cognos instance. From **figure 1**, **Server_1** is your existing IBM Cognos instance.

5. Click the field for **Content Manager URIs**, and click the edit button. The **Value - Content Manager URIs** dialog box appears.
   a. In the **Current values** list, change localhost to the name or IP address where you are running the instance.
      For example, change the value from http://localhost:9300/p2pd/servlet to http://Server_1:9300/p2pd/servlet. **Server_1** is your existing IBM Cognos instance.
   b. Click **OK**.

6. Click **File** then click **Save**.

7. Click **Action** then click **Start**.
   You will receive a warning during the **Testing the mail server connection** process. Click **OK** and **Continue** to continue starting the services. A mail server connection is not required.
   Starting the service will register the Application Tier Components instance in the content store database, and allow it to be used to process user requests.

**Test your Application Tier Components instance**

You can test your Application Tier Components instance using IBM Cognos Administration.

**Procedure**

1. Open a web browser.
2. Enter the **Gateway URI** value from IBM Cognos Configuration in the address bar, and press Enter.
   For example, enter http://Server_1/ibmcognos
3. On the **Welcome** page, click **Administer IBM Cognos Content**.
4. On the **Configuration** tab, click **Dispatchers and Services**.
   The displayed list includes a URL for both your original IBM Cognos instance and your Application Tier Components instance. The URLs appear as http://servername:port_number/p2pd.
Add a web gateway

You can also add a second gateway component. You install the gateway on another computer. Users can access your IBM Cognos portal from either gateway you set up. Or, more typically, a router would be used to distribute user access between the gateways.

Adding gateway instance will make your installation appear as shown in the following diagram.

![Diagram showing web gateway setup]

**Install a web gateway**

You install a gateway selecting only that component in the installation wizard. You must install the gateway on a computer where you have a web server installed.

From [Figure 3](#), you would perform this task on your Server_3 computer.

**Procedure**

1. Insert the IBM Cognos product disk or go to the location where the installation files were downloaded and extracted.
   
   To manually start the installation wizard, go to the operating system directory and then double-click the issetup.exe file.

2. Select the language to use for the installation.
   
   The language that you select determines the language of the user interface. You can change the language of the user interface to any of the installed languages after installation.
3. On the Component Selection page, expand IBM Cognos Business Intelligence Server to display the components.

4. Click Application Tier Components and Content Manager so that they indicate Not selected. Ensure only Gateway is indicated as Selected.

5. Click Next and follow the directions in the wizard to complete the installation.

6. When you are prompted about installing non-English product documentation, click OK to continue.

Configure the gateway

You must configure the gateway components to connect to an Application Tier Components instance in your environment. If you have added more than one Application Tier Components instance, you can add the URIs for all of the instances.

Procedure

1. For your gateway installation, open IBM Cognos Configuration.
2. In the Explorer pane, click Environment.
3. Click the field for Dispatcher URIs for gateway, and click the edit button.

   The Value - Dispatcher URIs for gateway window appears.
   a. In the Current values list, change localhost to the name or IP address of the instance where you installed all of the IBM Cognos components.
      For example, change the value from http://localhost:9300/p2pd/servlet to http://Server_1:9300/p2pd/servlet.
      In the diagrams, Server_1 is the instance where all of your IBM Cognos components are installed.
   b. If you have added an Application Tier Components instance to your installation, click Add, and change the value from http://localhost:9300/p2pd/servlet to http://Server_2:9300/p2pd/servlet
      The first value in the list represents the default dispatcher. If that dispatcher becomes unavailable, the second dispatcher will become the default dispatcher.
      From figure 3 Server_2 is your existing IBM Cognos instance.
   c. Click OK.
4. Click File then click Save.

Configure your web server

You must configure your web server before users can connect to the IBM Cognos BI portal.

Using the CGI gateway on Microsoft Internet Information Services version 7

If you are using Microsoft Internet Information Services (IIS) version 7 or later, use the following task to configure the CGI gateway.

Procedure

1. Click Start then click Control Panel then click Programs and Features.
2. Click Turn Windows features on or off.
3. If you are using Microsoft Windows 2008 Server, take the following steps:
   a. Click Server Manager then click Roles then click Web Server (IIS).
b. If CGI is set to **Not installed**, select CGI and click **Add Role Service**.

4. If you are using Microsoft Windows 7, take the following steps:
   a. Expand **Internet Information Services** then click **World Wide Web Services** then click **Application Development Features**.
   b. If CGI is not selected, select CGI.
   c. Click **OK**.

5. In the **Internet Information Services (IIS) Manager** console, under **Connections**, select your server name.
   If you are using Microsoft Windows 7, click **Start > Control Panel > System and Security** then click **Administrative Tools** to access the IIS Manager console.

6. In the **IIS group**, double-click **ISAPI and CGI Restrictions**.

7. Under **Actions**, click **Add**.

8. Enter the path to the **cognos.cgi** file. The file is located in the `c10_location\cgi-bin` directory.
   You must enter the full path including the filename. If the path includes spaces, ensure you use quotation marks around the path. For example, enter: “`C:\Program Files\ibm\cognos\c10\cgi-bin\cognos.cgi`”

9. Enter a **Description**, such as Cognos CGI.

10. Select **Allow extension path to execute**, and click **OK**.

11. Under **Actions**, click **Edit Feature Settings**, select **Allow unspecified CGI modules**, and click **OK**.

12. Under **Connections**, expand **Sites**, and under your web site, add the virtual directories as shown in the table:

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos</td>
<td><code>c10_location/webcontent</code></td>
</tr>
<tr>
<td>ibmcognos/cgi-bin</td>
<td><code>c10_location/cgi-bin</code></td>
</tr>
</tbody>
</table>

13. Select the cgi-bin virtual directory you created.

14. In the **IIS group**, double-click **Handler Mappings**.

15. Under **Actions**, click **Add Module Mapping** and take the following steps:
   a. In **Request Path**, type `cognos.cgi`.
   b. In **Module**, select CgiModule.
   c. Leave **Executable (optional)** blank.
   d. In **Name**, enter a name for the entry, such as CognosCGI.
   e. Click **OK**.

**Results**

Users can access the CGI gateway by entering `http://servername/ibmcognos` in their Web browsers.

**Using the CGI gateway on Apache Server or IBM HTTP Server**
The default gateway configured in IBM Cognos Configuration is the CGI gateway. To use the CGI gateway, you must configure aliases for Apache Server or IBM HTTP Server.
**Procedure**

1. Go to the `Webserver_installation/conf` directory.
2. Open the `httpd.conf` file in an editor.
3. Ensure that both the server name and web server port number values are specified for the `ServerName` property.
4. Add the following:
   ```
   ScriptAlias /ibmcognos/cgi-bin "c10_location/cgi-bin"
   <Directory "c10_location/cgi-bin">
     AllowOverride None
     Options None
     Order allow,deny
     Allow from all
   </Directory>
   
   Alias /ibmcognos "c10_location/webcontent"
   
   <Directory "c10_location/webcontent">
     Options Indexes MultiViews
     AllowOverride None
     Order allow,deny
     Allow from all
   </Directory>
   
   The `<Directory>` directive is optional.
   
   **Tip:** Ensure that you define the `/ibmcognos/cgi-bin` alias before the `/ibmcognos` alias.
5. Save and close the file.
6. Restart the web server.

**Results**

Users can access the portal at `http://servername:port/ibmcognos`.

**Test your access to your second portal**

You can test your access to your second portal using your web browser.

**Procedure**

1. Open a web browser.
2. Test the connection to the IBM Cognos BI portal by typing the **Gateway URI** value from IBM Cognos Configuration. For example, type `http://Server_3/ibmcognos`.
   
   If you are on the computer where your web server is installed, you can enter `localhost` for the `host_name` value.

   From figure 3, `Server_3` is the instance where your additional gateway is installed.
Appendix. Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products.

See the IBM Accessibility Center (http://www.ibm.com/able) for more information about the commitment that IBM has to accessibility.

Keyboard Shortcuts for the Installation Wizard

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software.

The installation wizard uses standard Microsoft Windows operating system navigation keys in addition to application-specific keys.

Note: The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the installation wizard on the Windows operating system.

Table 5. List of keyboard shortcuts on a Windows operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the License Agreement page of the installation wizard.

Table 6. List of keyboard shortcuts on the License Agreement page

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in IBM Cognos Configuration on a Windows operating system.

Table 7. List of keyboard shortcuts for IBM Cognos Configuration on a Windows operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current configuration</td>
<td>Ctrl+S</td>
</tr>
</tbody>
</table>
Table 7. List of keyboard shortcuts for IBM Cognos Configuration on a Windows operating system (continued)

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close IBM Cognos Configuration</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>F2</td>
</tr>
<tr>
<td>Display the File menu</td>
<td>Alt+F</td>
</tr>
<tr>
<td>Display the Edit menu</td>
<td>Alt+E</td>
</tr>
<tr>
<td>Display the View menu</td>
<td>Alt+V</td>
</tr>
<tr>
<td>Display the Actions menu</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Display the Help menu</td>
<td>Alt+H</td>
</tr>
</tbody>
</table>
Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service. This document may describe products, services, or features that are not included in the Program or license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
IBM, the IBM logo, ibm.com, and Cognos are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at "Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

- Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
- Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.